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Category:Content
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 4 Additional features  ............................................................................................................................ 6

is available from BlueSpice 4.2.
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1.  

2.  

What are file attachments?

File attachments are links on wiki pages that link directly to an uploaded file (Word document, 
PDF, image file,...). From BlueSpice 4.2, file attachments are directly integrated into a wiki page.

Create attachments

To create file attachments:

Choose "attachments" and click . Done

Magic word "attachments"

Save the page. You will now see the new attachments area.

Important! Attachments on pages before BlueSpice 4.2 will be moved to the page content during the 
update to 4.2. This triggers a new revision (version) of each affected page. Pages that have been in 
approved state will have a new draft version.

https://en.wiki.bluespice.com/wiki/File:magicword-attachments.png
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2.  

3.  

1.  

2.  

New attachments area

Upload a new file to the wiki (button 1). Alternatively, choose an already existing file (button 2).

Elements of the attachments area

The appearance of the attachments area can be adjusted with settings in the attachments tag. 
To set the parameters, go to the edit mode of the page and click on the attachments area. The 
tag inspector opens. It consists of two areas:

Prefix, Categories, Description: Default values for files that are newly uploaded to the wiki via the 
attachments section. The default values are also used when the toggle switch "Skip upload options" is 
activated. In this case, the files are transferred directly to the wiki without any further upload dialogs. 
The standard upload options are applied.
Toggle switches that show or hide different columns in the attachments area.

Note: When uploading a new file, you should check the file/page name for unusual special characters 
(e.g., , , ,  , ,  , , , ). Change the name to include only standard characters, since " % / < > [ ] { }
the server file system could have problems with them or since some characters have special meanings 
in MediaWiki.
The special characters , , ,  can be used and are translated into their equivalent %-( ) & +
hex notation.

 will be converted to spaces, unless it is part of an existing namespace prefix.:

https://en.wiki.bluespice.com/wiki/File:attachment-area.png
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2.  

attachments inspector

The following parameters are available (all settings are optional):

Parameter Description

Title Title that should be shown at the top of the attachments area.

1 Prefix

A prefix that should automatically be added during the upload.

Example:

Product: (prefixes the filename with the namespace-prefix for the  Product
namespace)

1 Categories Default categories for newly uploaded files.

1 Description Default description for newly uploaded files.

2
Skip upload 
options

When uploading new files, they are uploaded directly to the wiki without showing a 
further settings dialogs. The standard upload options (prefix, categories, description) 
are applied.

2
Hide 
version

The "Latest version" column is hidden. This column shows the last edit date.

2 Hide editor The "Editor" column is hidden. This column shows the last editor.

2 Show size The "Size" column is displayed. This shows the file size in KB/MB.

https://en.wiki.bluespice.com/wiki/File:attachments-inspector.png
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1.  
1.  

2.  

Parameter Description

2
Show 
categories

The "Categories" column is displayed. If a file is categorized, the categories are listed 
here.

Additional features

Click the x-icon to remove an attachment from the attachments pane.
Click the i-icon to open the file description page.
Click on the filter symbol in the header bar to filter for terms in the file name.

Manual:Content organization

A guiding principle in a wiki environment is: All users can easily and immediately share their 
knowledge and collaborate on content. For this to happen, it is not necessarily important that 
users know how the wiki is organized.

Initially, a page can be created anywhere in the wiki, wherever a user has write access. It is, first 
of all, important that the information is shared. Where the resulting wiki page ultimately lives and 
how it is found does not have to be decided right away.

In practice, however, there are many relationships between the individual pages. In addition, 
there are often different target groups for different types of content.

Therefore, it is important for administrators to set up the wiki so that the content can be 
meaningfully organized. There are important areas to consider:

User roles and permissions
Elements for structuring content:

namespaces
categories
pages and subpages

The following is a simple example for content organization:

inhaltsorganisation

To clarify how these wiki functions can be used efficiently for a single wiki or wiki farm, a content 
organization and management concept should be developed. Consider the following areas:

Content strategy:
What types of content do you share on the wiki?

Who creates which content?
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1.  

2.  
3.  

2.  
1.  

2.  
3.  

3.  
1.  
2.  
3.  

Who creates which content?
Is there a need for pre-structured content formats?

Information architecture
How do I organize content, navigation paths and search capabilities to provide user-friendly access 
to existing information?
Who has what kind of access to the content?
What are the target groups for the different content areas?

Quality management
Which content must be checked and by whom?
Do you have content with a predefined life cycle?
Is all content meaningfully categorized?

If you don't have a content strategy or an information architecture and ideas about quality 
management in place when setting up a new wiki, don't hesitate to start using the wiki. Collect 
and create content as soon as the wiki is technically available. Just make sure that data 
protection aspects are clarified in advance and communicated accordingly when sharing 
company information. Through the search function and various special pages, the content can 
easily be searched and retrieved.

As the content grows, administrators can take inventory and structure the content based on that 
information and determine policies, processes and the information architecture. The most 
important decisions should be written down in a formal governance document. From then on, 
content will be created and organized according to the policies, processes and architecture 
decisions that are specified in this document.

Checklists

 allows inserting checklists and checkboxes for to-do lists with BlueSpiceChecklist
responsibilities and status settings.

Contents
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 1.2 Creating a drop-down list  .............................................................................................................. 9
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 2 Adding checklists in source editing mode  ....................................................................................... 10
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 4 Related info  ..................................................................................................................................... 11
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Magic word "checklist"

It is easy to insert simple checklists into any wiki page. When a wiki page has a checklist, any 
user with  rights can update the checklist values without switching into edit mode. checklistmodify
These are by default users in the role ,   and .editor author, maintenanceadmin bot

To create a checklist item:

Click  in the visual editor.Insert > More > Magic word

The visual editor

Click c  in the dialog window.hecklist

Magic word checklist

Click . Another dialog window appears.Done

Note: If a user with read permissions changes the value of a checkbox or drop-down list, the value will 
not be saved. Refreshing the page will show the last value that has been saved before.

https://en.wiki.bluespice.com/wiki/File:Manual:ve-magicword.png
https://en.wiki.bluespice.com/wiki/Link%3Dhttps://en.wiki.bluespice.com/wiki/File:Checklist2.png
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1.  

2.  

Dialog window for checklists

Now select the tab to select your checklist type:

Checkbox: creates an individual checkbox.
List: creates a drop-down menu.

A page can contain multiple checkboxes and lists.

Creating a checkbox

Toggle the switch in the dialog window on the checkbox tab to create an unselected checkbox. When 
this toggle is blue, the checkbox is pre-selected.
Select  The checkbox is now visible on the page. Write the text for a label or for an instruction insert.
next to the checkbox

After the page has been saved, all users can activate and deactivate the checkbox.

Creating a drop-down list

Selecting a checklist template

https://en.wiki.bluespice.com/wiki/File:Manual:magicword-dialog-EN.png
https://en.wiki.bluespice.com/wiki/File:Manual:Checklist4-EN.png
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1.  
2.  
3.  

Select an  in the  tab.existing option list List
Under Selected option, choose the default value.
Click Done.

After saving the page, all users can change the selected list value in read mode.

Defining an option list

Before a combobox can be created, a template for the list items needs to be available. For 
example, to create a list of pizzas, you need to create a page  with the following Template:Pizza
content:

* Choose pizza
* Margherita
* Prosciutto
* Salami
* Fungi|#00FF00
* Hawaii
* Gamberetti|#0000FF
* Diavolo
* Siziliana|#0000FF
* Quattro Formaggi|#00FF00

After saving this page, the list "Pizza" appears in the select menu .Option list

Colors can be assigned to each option using the color's . The color value #00FF00 HEX code
shows green text.

* Quattro Formaggi|#00FF00

Without specifying the color, text inherits the text color of the wiki page.

Checklist examples (checkbox and select menu)

Adding checklists in source editing mode

Checklists can also be added to a page using wikitext. The syntax for adding the tag is:

Checkbox:

https://en.wikipedia.org/wiki/Web_colors
https://en.wiki.bluespice.com/wiki/Link%3Dhttps://en.wiki.bluespice.com/wiki/File:Checklist5.png
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<bs:checklist type="check" checked="true" />

The value of the paramter  can be  or , depending on whether the checkbox checked true false
should initially be selected (true) or deselected (false). List:

<bs:checklist type="list" list="Template:Pizza" value="Choose pizza" />

The parameter  defines the template page that contains the list,  defines the initial list value
selection.

Once a checklist tag has been saved on a page, users can change its value in read mode.

Configuration

The following configuration can be changed in the :Config manager

Mark checklist changes as minor edit: If this setting is active, changes to a checklist (for example, 
checking a checkbox) in view mode are logged as minor edits. If this setting is inactive, a change to the 
checklist is recorded as a regular version in the page history.

minor edit

Related info

Reference:BlueSpiceChecklist

Technical Reference: BlueSpiceChecklist

https://en.wiki.bluespice.com/wiki/Manual:Extension/BlueSpiceConfigManager
https://en.wiki.bluespice.com/wiki/File:Manual:configmanager-checklistminoredit.png
https://en.wiki.bluespice.com/wiki/Reference:BlueSpiceChecklist
https://en.wiki.bluespice.com/wiki/Reference:BlueSpiceChecklist
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Ratings and recommendations

The extension  allows users to rate a page with up to five stars or to BlueSpiceRating
recommend the page.

Contents
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 1.1 Rating  .......................................................................................................................................... 13
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 2 Enable ratings or recommendations in a namespace  ...................................................................... 13
 3 Special pages  .................................................................................................................................. 14
 4 Deactivate ratings on a page  .......................................................................................................... 15
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Rate or recommend a page

Before a user can rate or recommend a page,  by an each feature needs to be activated
administrator.

Rating

A user simply selects the amount of stars for a rating at the end of a wiki page. The number of 
stars are then highlighted in yellow during the selection process.  A mouse-click confirms the 
rating. Only one rating per user is counted. New votes only change the average evaluation, but 
not the number of ratings. Users can change their rating at any time by choosing less or more 
stars.

The display of the ratings and recommendation features can be moved to the title area in the 
Config manager.

Recommendation

To recommend a page,  a user clicks on the link "Recommend" at the end of the page. To retract 
the recommendation, the user clicks on the link again.

Ratings and recommendations

Enable ratings or recommendations in a namespace

Administrators can activate both features for individual namespaces. To enable or disable them, 
go to  and edit the namespace settings:Global actions > Namespace manager

https://en.wiki.bluespice.com/wiki/Manual:Extension/BlueSpiceConfigManager#Positioning_of_skin_elements
https://en.wiki.bluespice.com/wiki/Manual:Extension/BlueSpiceConfigManager#Positioning_of_skin_elements
https://en.wiki.bluespice.com/wiki/File:BlueSpiceRating-footer.png
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Special pages

The special page  lists all pages that have been rated.Special:Rating

The special page  lists all pages that have been recommended.Special:Recommendations

Both pages can be accessed from the Global actions menu.

Global actions menu

https://en.wiki.bluespice.com/wiki/File:BlueSpiceRating-settings.png
https://en.wiki.bluespice.com/wiki/File:BlueSpiceRating-global_actions.png
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Deactivate ratings on a page

Users can also exclude individual pages from the rating system. For this, insert the following 
behavior switch at the bottom of the page in source view:

__NORATING__

Related info

Reference:BlueSpiceRating

Tag cloud

The extension  visualizes terms from your wiki based on importance. It can be included TagCloud
on any wiki page. The source for the tag cloud terms can be categories or searchstats.

Contents

 1 Inserting a tag cloud  ........................................................................................................................ 16
 2 Configuration  ................................................................................................................................... 16

 2.1 Common configuration  ................................................................................................................ 17
 2.2 Advanced configuration  ............................................................................................................... 17

 3 Examples  ......................................................................................................................................... 17
 3.1 Text  ............................................................................................................................................. 17
 3.2 3D canvas  .................................................................................................................................... 18
 3.3 List  ............................................................................................................................................... 18

 4 Related info  ..................................................................................................................................... 19

Technical Reference: BlueSpiceRating

https://en.wiki.bluespice.com/wiki/Reference:BlueSpiceRating
https://en.wiki.bluespice.com/wiki/File:tagcloud-example.png
https://en.wiki.bluespice.com/wiki/Reference:BlueSpiceRating
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Inserting a tag cloud

A tag cloud can be inserted directly in source editing mode with the tag . To <bs:tagcloud />
insert a tag cloud with , select .VisualEditor Insert > Magic word > Tag cloud

Configuration

If tag is added using VisualEditor, a configuration dialog appears. It shows configuration options 
in two tabs:  and .Common Advanced

https://en.wiki.bluespice.com/wiki/Manual:Extension/VisualEditor
https://en.wiki.bluespice.com/wiki/File:TagCloud1.png
https://en.wiki.bluespice.com/wiki/File:TagCloud2.png
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Common configuration

Parameter
Display 

name
Description

renderer Type

Mode of rendering the cloud
List
Text (font size depends on frequency)
3D: rotating, ineractive view

width Width
Part of the page width taken by the cloud in percent or pixels (e.g., 50%, 
150px)

showcount Show count Whether to show the numeric frequency of the term in the cloud

Advanced configuration

Parameter
Display 

name
Description

store Store Source of the data - category or searchstats

minsize
Min font 
size

Smallest possible font displayed in the cloud

maxsize
Max font 
size

Biggest possible font displayed in the cloud

exclude
Exclude 
pages

List of categories to exclude from the cloud, separated by comma - 
"category1, category2, category3"

Examples

Text

Tag parameters:

<bs:tagcloud count="10" minsize="12" maxsize="34" exclude="Imported vocabulary, 
Project" />

Output:



Category:Content

17.04.2024 This document was created with BlueSpice Page  of 18 24

Shows a tag cloud with the 10 (count) categories that have the most page associations. The 
smallest possible font-size is 12 pixels (minsize) and the largest possible font-size is 34 pixels 
(maxsize). The categories  and  have been excluded from the output.Imported vocabulary Project
Since the data source  is the default for a tag cloud, it is not necessary to specify it in category
the tag.

3D canvas

Tag parameters:

<bs:tagcloud renderer="canvas3d" store="category" count="15" minsize="12" 
maxsize="40" showcount="false" />

Output:

The renderer  produces an interactive tag cloud. The cloud rotates when the cursor canvas3d
hovers over the tag cloud. It shows the 15 (count) most tagged categories. It is important to set 
the count limit, since the default count is set to 40, wich produces a 3D cloud where the results 
are hard to distinguish visually. The data source is set to category (store). This is optional, since 
category is the default store value. The font sizes range from 12 pixels (minsize) to 40 pixels 
(maxsize). How many pages and files are associated with each category is not shown (

).showcount="false"

List

Tag parameters:

<bs:tagcloud renderer="list" store="searchstats" count="5" />

Output:

The renderer type  produces a simple unordered list.list

https://en.wiki.bluespice.com/wiki/Special:FilePath/tagcloud-example-exclude.png
https://en.wiki.bluespice.com/wiki/Special:FilePath/tagcloud-canvas3D.png
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The tag cloud of type  ignores the following parameters: , list minsize maxsize

Related info

Reference:BlueSpiceTagCloud

My tasks

Tasks are created in different contexts. For each task, the wiki sends a notification to the 
assigned user and adds a task card to the personal task page. This page is accessible via 

 in the user menu:Personal Tools > Tasks

Technical Reference: BlueSpiceTagCloud

https://en.wiki.bluespice.com/wiki/Special:FilePath/tagcloud-list-searchstats.png
https://en.wiki.bluespice.com/wiki/Reference:BlueSpiceTagCloud
https://en.wiki.bluespice.com/wiki/Reference:BlueSpiceTagCloud
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Tasks link in the Personal Tools

Tasks in checklists

Checklist items can be assigned to a person via a user mention.

Workflow tasks

Workflow participants receive tasks from workflow steps.

Read confirmations

Users assigned to a page need to complete a read confirmation task.

Templates

https://en.wiki.bluespice.com/wiki/File:Manual:notifications-menulink.png
https://en.wiki.bluespice.com/wiki/Manual:Extension/SimpleTasks
https://en.wiki.bluespice.com/wiki/Manual:Extension/Workflows#Aufgaben
https://en.wiki.bluespice.com/wiki/Manual:Extension/BlueSpiceReadConfirmation
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What is a template?

A template provides reusable content in the wiki. This content is then integrated into numerous 
pages. The template can be content-based (text template) or structure-based (layout template), 
or a combination of both.

A typical example is an infobox that is formatted to look identical on all pages.

A template can also be integrated into a .page template

Document control box at the beginning of a document

Characteristics of a template

A template:

allows you to insert reusable content with a placeholder (transclusion)

is usually located in the "Template" namespace

https://en.wiki.bluespice.com/wiki/Manual:Extension/BlueSpicePageTemplates
https://en.wiki.bluespice.com/wiki/File:Template_IMS_Work_instruction.png
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is usually located in the "Template" namespace
can have parameters
often contains logic
is used to maintain a "look and feel".

Create and embed a template

A new template is always created in the  namespace.Template

A template is inserted into a page by enclosing the name of the template in the source code in 
two curly brackets:  Templates are inserted by users via:{{NotificationBox}}.

the Insert menu item of the editor toolbar
as a Content droplet

Edit a template

Changes to a template affect all pages that contain that template. Before modifying existing 
templates, you should check which pages use the template. To find these pages, click ...All 

 in the page actions menu.actions > links to this page

Built-in variables

Each MediaWiki has a set of  that are not pages in the "Template" namespace, built-in variables
but are still used as templates.

For example, the variable  returns the current UTC time.{{CURRENTTIME}}

Describe parameters via TemplateData

The MediaWiki extension  allows template parameters to be described in such a TemplateData
way that they can be easily edited by users in the Visual Editor via a form.

Format template

If a template needs to be specially formatted, e.g. with background color, text spacing or special 
font formatting, this can be achieved using MediaWiki:Common.css. The formatting can therefore 
be used multiple times for other templates. If the formatting is specifically limited to this 
template, it will be created on a subpage of the template using the  tag. The TemplateStyles
advantage of this is that the style specifications can be easily exported together with the 
template and imported into another wiki.

Further information

Using a template is essentially a . It is also possible to use pages as templates that are not transclusion
in the "Template" namespace. However, this should be done carefully as some features require the 
pages to be in the template namespace.
Templates can also be used to define the output of . For more information, see semantic query Semantic 

. (This is an example where the pages absolutely must be in the template namespace.)MediaWiki
The complete list of all wiki pages that are in this namespace can be found on the  Special:Templates

https://en.wiki.bluespice.com/wiki/Manual:Extension/VisualEditor
https://en.wiki.bluespice.com/wiki/Manual:Extension/ContentDroplets
https://en.wiki.bluespice.com/wiki/Manual:Extension/BlueSpiceInsertMagic
https://www.mediawiki.org/wiki/Help:TemplateData#Template_data_editor_method
https://www.mediawiki.org/wiki/Extension:TemplateStyles
https://www.mediawiki.org/wiki/Transclusion
https://www.semantic-mediawiki.org/wiki/Help:embedded_query
https://www.semantic-mediawiki.org/wiki/Help:Template_format
https://www.semantic-mediawiki.org/wiki/Help:Template_format


Category:Content

17.04.2024 This document was created with BlueSpice Page  of 24 24

The complete list of all wiki pages that are in this namespace can be found on the  Special:Templates
page.

Related info

https://meta.wikimedia.org/wiki/Help:Template
https://www.mediawiki.org/wiki/Help:Templates

https://meta.wikimedia.org/wiki/Help:Template
https://www.mediawiki.org/wiki/Help:Templates
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